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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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HP Discovery and Dependency Mapping 
Inventory 

Release Notes 
Software version: 7.70 / June 2010 

This document provides an overview of the changes made to Discovery and Dependency Mapping Inventory 
(DDM Inventory) for version 7.70. It contains important information not included in the manuals or in the 
online help. 

Conventions Used in this Document  

In This Version

New Features

• Scanner Enhancements 

— Support for execution of pre-scan and post-scan scripts 

— iLO support 

— System serial number collection improvements 

— Scanner data collection improvements 

— Manual scanner execution control 

• Software Recognition 

— Partial software recognition 

• Virtualization 

— VMware hosts: Remote inventory of ESX and ESXi 

— Hyper-V: Guest Identification 

• Scanner Supportability 

— Improved logging for scanner execution 

— Agent/scanner deployment error reporting 

• Changes in DDM Inventory Licensing Mechanism 

• New Device Types 

Compatibility Notes

Scanner Support Information

Obsolete Features

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds
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Conventions Used in this Document  
By default, when you install the DDM Inventory Server software, all the components will be in one of the 
locations specified in the following table. The placeholders are used to represent the DDM Inventory 
program and data folders referenced in this document: 

Folder Placeholder Platform Default Location 

Windows  
Server 2008 x64 

C:\Program Files (x86)\Hewlett-
Packard\DDMI\7.70

Program 
Files 

<InstallDir> 

All others C:\Program Files\Hewlett-Packard\DDMI\7.70

Windows  
Server 2008 

C:\ProgramData\Hewlett-Packard\DDMIData 
Files 

<DataDir> 

Windows Server 
2003 

C:\Documents and Settings\All 
Users\Application Data\Hewlett-Packard\DDMI

You can customize both of these locations when you install the DDM Inventory Server. 
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In This Version 

Introduction 

These release notes are for DDM Inventory 7.70. This new version of the product is the upgrade path for 
users of DDM Inventory 7.5x and 7.6x.  

If you want to see what features have been introduced in previous versions of DDM Inventory (formerly 
called Enterprise Discovery), you can read the Release Notes for those versions available on your installation 
CD under bin\documentation.  

License Schema 

Each DDM Inventory server can collect data from a maximum of 50,000 inventoried devices and 60,000 
discovered devices in total. The port limit is 150,000 ports (whichever comes first). A DDM Inventory 
Aggregator can support 50 servers and up to 500,000 devices. 

Updated Third-Party Components  

• Apache 2.2.15 

• MySQL 5.1.42 

• Java Runtime Environment (JRE) 1.6.0_18 
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New Features  
DDM Inventory 7.70 provides several new features to extend existing functionality and provide users with 
new capabilities. Besides general product enhancements, this release offers significant additional 
capabilities in the areas of scanning, reporting, and VMware hosts support. The following sections describe 
these features. 

Scanner Enhancements 

Support for execution of pre-scan and post-scan scripts 

In this release, DDM Inventory introduces new pre-scan and post-scan scripting capability.  This feature 
allows administrators to create and execute scripts on scanned devices as part of the standard DDM 
Inventory scanning process. It expands the capabilities of standard scanner detection by capturing custom 
data on specific hardware, settings, or applications that the scanner does not currently collect in its 
inventory data. External scripts can be run as part of the scanner operation to capture this additional 
inventory information. 

 
By default, the Scanners will not run the pre-scan and post-scan scripts until you enable this 
option in the scanner profile. For detailed information, refer to “Configuration Profiles” in the 
“Discovery Configuration Overview” section in the Installation and Initial Setup Guide. 

You can create the pre-scan and post-scan script files based on your own requirements. But you must save 
the files with the designated file names and store them in the designated directories.  For more detailed 
information, refer to the “Pre-Scan and Post-Scan Scripts for Collecting Custom Hardware Data” section in 
the Configuration and Customization Guide. 

iLO support 

DDM Inventory 7.70 provides the ability to identify and associate Remote Management Interface Cards 
(iLO) with the servers they manage.  In this release, DDM Inventory can perform the following actions: 

• Associating an iLO card with the DDM Inventory server and displaying the iLO information (such as the 

iLO icon , the iLO IP address, and the port information) in the Device Manager. 

• Using the other IP address assigned to the iLO card for the Simple Network Management Protocol 
(SNMP), agent, or virtualization unless it is the last possible solution for SNMP management. 

• Added a report for the iLO card vendor and the iLO card type (such as HP iLO, HP iLO 2, or LO100). To 
view the iLO card report, go to Server > Reports > Remote Management Cards. 

System serial number collection improvements 

DDM Inventory has improved capability for collecting hardware serial numbers. This includes 
enhancements for collecting the serial numbers for Solaris and HP-UX systems. 

Scanner data collection improvements 

DDM Inventory 7.70 has an updated Intel CPU count detection algorithm for the Windows, Linux, and 
Solaris operating systems. As a result, DDM Inventory can get more accurate CPU count results, including 
the core number, the physical number, and the logical processor number for the latest Intel CPU models. 
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Manual scanner execution control 

This release adds more manual scanner execution controls on the scanner commands through the following 
three new parameters: 

• -v: Specify that the scanner should not make the local scan file read-only or hidden. 

• -t: Override the default path for storing temporary files. 

• -l: Override the default file name of the local scan file, local$.xsf. If the path is specified in the file 
name, then the default path for storing the local scan file is also overridden. 

Software Recognition 

Partial software recognition 

Prior to DDM Inventory 7.70, partial recognition data was only available in the Analysis Workbench (entries 
marked as “check ver”). Now the Viewer, the Scan Data Viewer, and the application reports also include the 
partially recognized applications together with the fully recognized applications. For the partially recognized 
applications, only a partial match is found in the library, indicating that a different version of the 
application might be installed. The version shown is the closest one found in the SAI. 

Partial software recognition provides a more complete view of the software installed on a target device.  It 
provides a degree of resiliency to software updates.  Partial recognition results should be reviewed to ensure 
accuracy and may in some cases result in customers deciding to add new entries in their SAI. 

• Changes in the Viewer:  

— Summary tab: This tab now displays fully recognized applications numbers and partially recognized 
applications numbers.  

— Software Applications tab and Software Utilization tab:  

1. Added a new Recognition column in these two tabs. For SAI-based recognition, this column 
displays Full for fully recognized applications or Partial for partially recognized applications. 
For Installed applications, this column displays Installed Applications.  

2. (Only for the SAI-based recognition) Added a new menu item in the right-click menu on the 
Recognition column: Show applications > Fully recognized, Partially recognized, or Both. 

• Changes in the Scan Data Viewer: The same changes as in the Viewer (above).  

— In the Software Applications tab and Software Utilization tab, DDM Inventory has made the 
following changes:  

1. Added a new Recognition column in these two tabs. For SAI-based recognition, this column 
displays Full for fully recognized applications or Partial for partially recognized applications. 
For Installed applications, this column displays Installed Applications. 

2. (Only for the SAI-based recognition) Added a new menu item in the right-click menu on the 
Recognition column: Show applications > Fully recognized, Partially recognized, or Both. 

• In the application reports, added the following three navigation links to view application data:  

— Full: Default mode. Shows only fully recognized applications.  

— Partial: Shows only partially recognized applications.  

— Both: Shows both fully and partially recognized applications. You can refer to the Recognition 
column to differentiate between the partially and fully recognized applications. 
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Virtualization 

VMware hosts: Remote inventory of ESX and ESXi 

DDM Inventory 7.70 delivers a new remote inventory capability that collects inventories for VMware ESX 
and ESXi hypervisors. This new capability enables DDM Inventory to collect host inventory information 
without the need to install agent/scanner on VMware ESX and ESXi hosts. 

DDM Inventory provides two methods for collecting the inventory of VMware hosts: 

• Using DDM Inventory server, with the Inventory VMware hosts function enabled 

You can select the Inventory VMware hosts checkbox from Server > Admin > Discovery Configuration > 
Configuration Profiles. DDM Inventory will then collect inventory information for VMware hosts when 
running the discovery process on the VMware hosts themselves, or the VirtualCenter that manages 
these hosts.  

You can view the status of the Inventory VMware hosts from the Discovery Configuration table in the 
Diagnosis panel. 

• Using the Standalone VMware Remote Scanner  

The Standalone VMware Remote Scanner is a command line utility used to remotely scan a VMware 
server or VirtualCenter. With this scanner, the DDM Inventory server does not need to connect to the 
VMware servers or VirtualCenters directly. Instead, the Standalone VMware Remote Scanner can run 
on any server that can connect to the VMware ESX or ESXi host or VirtualCenter. This feature adds 
flexibility in complex installations. It enables VMware hosts to be inventoried in situations where they 
are not directly visible to the DDM Inventory server (such as when they are separated by firewalls or in 
different network segments). This function is provided for ad hoc inventory scanning, or to assist with 
troubleshooting and should not be used for ongoing VMware host inventory data collection. For detailed 
information, refer to the “Standalone VMware Remote Scanner” section in the Reference Guide. 

Hyper-V: Guest Identification 

In this release the scanners can identify Microsoft Hyper-V guest machines. You can choose to terminate the 
scanner running inside these machines under the environment as shown below under Scanner Generator > 
Scanner Options > Miscellaneous. 

• Hyper-V (Only for Windows, Linux, and Solaris x86 scanners) 

Scanner Supportability 

Improved logging for scanner execution 

DDM Inventory 7.70 introduces logging for scanner execution status in the Device Manager. It enables you 
to diagnose a failed scanner workflow or to examine logs or error messages written by the scanners.  

In the Device Manager, the scanning workflow status is shown when DDM Inventory executes the following 
actions from the Update Model drop-down list:  

— Upgrade Agent 

— Run Scanner 

— Retrieve Scan File 

— Run Agentless Scanner 
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Agent/scanner deployment error reporting 

DDM Inventory 7.70 introduces scanner status reporting. The new reporting can help in troubleshooting 
scanner deployment and execution issues. DDM Inventory 7.70 provides a unified view of the workflow 
status with the new status report: Scanner execution details. To access this report, go to Server > Status > 
Devices Status > Scanner Execution Details.  

For the scanners that the DDM Inventory server automatically executed with or without an agent, you can 
view the following details on scanner execution progress:  

— The current execution status of the scanners 

— The scan start time and duration 

— The scanner process completion code if it is finished 

— The scanner process ID 

— The scanning stage 

Changes in DDM Inventory Licensing Mechanism 

With this release of DDM Inventory, the backend licensing mechanism was changed from using legacy 
Peregrine license files to an HP standard “Autopass” system. Autopass is a separate tool that can be 
accessed from Start > Programs > Hewlett-Packard > DDM Inventory 7.70 > Autopass after you successfully 
install the DDM Inventory server. Autopass provides a self-service portal to obtain licenses for DDM 
Inventory by providing the “Order Numbers”. The DDM Inventory license is “node-locked”. One license is 
tied to a DDM Inventory server. The client tools no longer require a license. 

New Device Types  

DDM Inventory can now successfully identify one new device type. The following table shows the new device 
and the icon that represent it: 

Icon Device  

 
Management Processor (MP) for HP 
Integrity and HP9000 servers 

 

For a comprehensive list of device types, refer to Help > Classifications > Device Types in the DDM 
Inventory Web UI. 
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Compatibility Notes  

Reports Database Changes 

Additions 

• Added table Aggregate.hwsmbiosOnboardDevicesExtendedInformation. 

• Added table Aggregate.hwAssetCustomData. 

• Added table Aggregate.SWSubComponentPartial. 

• Added table Aggregate.PortRMCType. 

• Added column Device_PreferredAgentAddress to table Aggregate.Device. 

• Added column hwNICIPAddressFlags to table Aggregate.hwNICIPAddresses. 

• Added columns hwsmbiosSystemBIOSRelease and 
hwsmbiosEmbeddedControllerFirmwareRelease to table Aggregate.hwsmbiosBIOSInformation. 

• Added columns hwsmbiosSystemSKUNumber and hwsmbiosSystemFamily to table 
Aggregate.hwsmbiosSystemInformation. 

• Added columns hwsmbiosProcessorCoreCount, hwsmbiosProcessorCoreEnabled, 
hwsmbiosProcessorThreadCount, and hwsmbiosProcessorCharacteristics to table 
Aggregate.hwsmbiosProcessorInformation. 

• Added columns hwsmbiosSlotSegmentGroupNumber, hwsmbiosSlotBusNumber, 
hwsmbiosSlotDeviceNumber, and hwsmbiosSlotFunctionNumber to table 
Aggregate.hwsmbiosSystemSlots. 

• Added column hwsmbiosMemoryArrayRank to table Aggregate.hwsmbiosMemoryDevice. 

• Added column hwNICIPAddressDNSNames to table Aggregate.hwNICIPAddresses. 

• Added column PortRMCtype_ID to table Aggregate.Port. 

• Added column hwRecognitionMethod to table Aggregate.hwRecognitionInfo.  
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Scanner Support Information  
All Scanners and Agents supported in the 7.6x releases of this product are supported in the 7.70 release. 
Refer to the Compatibility Matrix for the 7.70 release of interest for the list of all supported platforms. 

 
When an install is upgraded from a previous release, it is possible to use the Scanners and 
Agents from previous releases if you explicitly specify the Scanner and Agent versions using the 
configuration options on the following pages: 
Administration > System Configuration > Scanner deployment

Administration > System Configuration > Agent communication
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Obsolete Features  

SAI Update Wizard 

The SAI Update Wizard component was removed from DDM Inventory 7.70. 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site: 
http://www.adobe.com/

The following PDF documents are available in the DDM Inventory Web UI: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 
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Installation Notes 
Instructions for installing DDM Inventory are documented in the Installation and Initial Setup Guide 
provided in Adobe Acrobat (.pdf) format.  

 Perl, MySQL, Tomcat and Apache are standard parts of the DDM Inventory, included with each 
server installation. If you have these components installed already, make sure to remove them 
before installing DDM Inventory. You may NOT substitute any other technologies in place of the 
standard installation. 

Software and Hardware Requirements  

The following sections detail the requirements for the DDM Inventory server and client components, 
respectively. 

Client Requirements 

The DDM Inventory client components (Analysis Workbench, SAI Editor, System Panel, and Viewer) have 
the following requirements: 

Resource Requirement 

Operating System Windows XP/Vista, Windows Server 2003/2008, Windows 7 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

See Help > Compatibility Matrix in the DDM Inventory GUI for 
versioning information 

Server Requirements 

The DDM Inventory Server can be installed on 32-bit versions of Windows Server 2003 (SP1, SP2), Windows 
2003 R2, or Windows Server 2008 (SP1), and the 64-bit version of Windows Server 2008 (SP1 or SP2), or 
Windows 2008 R2. For information about all supported platforms, refer to the Compatibility Matrix. 

Recommended Server Platforms 

For large servers (up to 50,000 devices), the following is recommended: 

• HP Proliant Model: DL380 G6  

• CPU: 8 Core (Intel® Xeon® 5500 series)  

• Memory: 8 GB 

• Disk: See the Storage Requirements section below. 

For medium servers (up to 15,000 devices), the following is recommended: 

• HP Proliant Model:  DL380 G6  
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• CPU: 4 Core(Intel® Xeon® 5500 series) 

• Memory: 6 GB 

• Disk: See the Storage Requirements section below. 

Sample Server Scenarios 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB for the DDM 
Inventory installation. 

The information presented below is for illustrative purposes only.  Proper sizing of the DDM Inventory 
server(s) may require assistance from a qualified architect.  HP recommends utilizing experienced resources 
to assist in architecture and the initial deployment of DDM Inventory.  Among the factors that need to be 
considered and which will impact the infrastructure architecture are the following: 

• Number of and distribution of devices (such as if slow WAN links exist between large population groups) 

• Type of and amount of information collected (examples below demonstrate the impact software 
utilization will have on overall system capacity) 

• Frequency of scans (the example below assumes a bi-weekly scan interval, more frequent scanning may 
require additional server capacity) 

• Amount of data collected (the examples below assume an average scan file size of ~250KB, which is 
representative of an average PC (large servers may generate considerably more data and therefore require 
additional capacity to process the data) 

• Environmental factors, such as integrations with other products, network characteristics, and 
operational requirements may impact the architecture of the DDM Inventory solution 

• The number of XML Enrichers that are running on the server 

• The settings in the virus checker installed on the server. Virus checking can add significant overhead. 

Table 1 – Suggested Hardware Requirements 

Discovered 
Devices 

Inventoried 
Devices Ports A

gg
re

ga
ti

on
 

A
u
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m
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ed

 
In

ve
n

to
ry

 

T
op

ol
og

y*
 

Memory 
(GB) CPU** 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x   3*** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  
   2 

2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000  x x 7 2+ CPUs or cores 260 
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Discovered 
Devices 

Inventoried 
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Memory 
(GB) CPU** 

Disk 
(GB) 

3.6 GHz 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 
2 CPUs or cores 
3.6 GHz 50 

* DDMI Topology is a network management component of DDM Inventory. It is no longer available for sale 
to new customers, but still available to existing Topology customers. 

** CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP DDM Inventory consists of multiple processes, many of 
which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 
technologies such as Intel® Hyper-Threading and Multi-core. 

*** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

• “Backup Scan Files” is enabled (on average, each scan file is 250KB) 

• “Delta scanning” is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

• “Statistic Export” is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

Storage Requirements  

DDM Inventory is a highly I/O intensive application. High I/O performance of the disks where the data 
resides is crucial to the correct operation of DDM Inventory. Disks need to reside local to the DDM Inventory 
server or on a high performance SAN.  Network drives and clusters are not supported. Some customers have 
reported problems with SAN environments so they are not recommended.    

Benchmark your disk I/O performance prior to installing DDM Inventory for management of any large 
environment. For a medium to large DDM Inventory server deployment, minimum recommended 
throughput (as benchmarked on an idle system when the DDM Inventory server is not running) is  
70 MB/sec for read accesses and 40MB/sec for write accesses. 

Your disk space requirements may differ depending on how you are using DDM Inventory. 

 For performance reasons, the disk where DDM Inventory data is stored should have at least 4K 
clusters. 

For the average size of scan files, refer to the “Disk Space Considerations” chapter in Installation and Initial 
Setup Guide. The inventory data collected in the scan file is stored in compressed format. For processing, the 
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data is extracted and populated into the database. In addition, if delta scanning is enabled, DDM Inventory 
keeps a copy of the original scan file as well as the enriched copy. Because of these extra disk space 
requirements, we recommend that you budget at least 5 times as much disk space for each device being 
scanned. 

 If your average scan file size is large, adjust your disk space requirements accordingly. 

Recommended Fault Tolerance Configurations 

The recommended fault tolerance configurations are the following: 

• Raid 1 

• Raid 1+0 

DDM Inventory must be installed on a local disk. It cannot be installed on network drives, SAN drives, or 
clustered devices. DDM Inventory has been tested and can be successfully installed in a RAID (redundant 
array of independent drives) level 0 and level 1 environment.   

RAID level 0 uses a striped disk array strategy that does not provide fault tolerance. Data striping spreads 
out blocks of each file across multiple disk drives. In our test environment we use 2 drives. This 
configuration does not provide for redundancy. It improves performance but does not deliver fault tolerance. 
If one drive fails then all data in the array is lost. 

RAID level 1 uses a mirrored set strategy that provides fault tolerance from disk errors and single disk 
failure. It results in increased read performance with very small performance degradation when writing. The 
array continues to operate as long as at least one drive is functioning.  

Because it offers the best tradeoff of performance and reliability, level 1 is the recommended RAID platform 
for DDM Inventory. For large networks, level 0 can also be used if performance is more important than fault 
tolerance. RAID level 5 is not supported. 

Upgrading from Earlier Releases 

For information about upgrading from earlier releases of DDM Inventory refer to the “Upgrade and 
Migration Scenarios” chapter in the Installation and Initial Setup Guide. 
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Enhancements and Fixes 
The following items were added or fixed in the current software release. Table 2 lists enhancements to 
existing features or behavior. Table 3 lists problems that were fixed (identified by error tracking number). 

Table 2 – Enhancements 

Number Location Description 

 Scanners 

For each detected IP address, the scanner can detect DNS 
names separated by spaces in the 
hwNICIPAddressDNSNames field. 

 XML Enricher 

DDM Inventory introduced a new hardware-related field 
hwRecognitionMethod to specify what recognition 
method is used by the XML Enricher to conduct 
application recognition. 

 Server 

Trimmed database logs for the VMware discovery 
command to 10K as the content could exceed several 
megabytes in some cases. 

QCRQ1C17706 Scanners 

The Scanner can report LPAR, vPar, and nPartition flags 
and you can view them from Viewer > Hardware Data > 
Operating System Data > Virtual Machine Data > Virtual 
Machine Type. 

QCRQ1C17707 Scanner Generator 

Four new checkboxes have been added to Scanner 
Generator > Scanner Options > Miscellaneous. With these 
checkboxes, you can terminate the Scanner running in the 
Hyper-V, LPAR, vPar, or nPartition environments. 

QCCR1C19107 Viewer 
The Windows Viewer can show executable and archive 
type differences when comparing scan files. 

QCCR1C20104 Solaris Scanner 
The Scanner has been improved to correctly collect system 
serial numbers entered using the SNEEP utility. 

QCCR1C20206 AIX Scanner 
The Scanner has been improved to correctly collect AIX 
BIOS serial numbers. 

QCCR1C20250 HP-UX Scanner 
The Scanner has been improved to correctly retrieve 
serial numbers on some old HP-UX platforms. 

QCCR1C29395 
Reports > Network 
Documentation 

DDM Inventory improved the CSV export performance in 
the reports: Device Inventory by UNSPSC, Device 
Inventory Summary, Device Inventory By Category, 
Device Inventory By Virtual LAN, and Port Inventory By 
Virtual LAN. 

QCCR1C29621 

Server > Device 
Manager > Diagnosis > 
Traceroute 

The traceroute diagnosis now works correctly on non-
English operating systems. 
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Number Location Description 

QCCR1C29672 SAI Editor 

The SAI Editor allows you to multi-select and multi-
update the "relationship to application" when teaching 
unknown files. 

QCCR1C31578 Server 

The XML Enricher memory limit has been increased from 
384MB to 512MB. This should prevent the XML Enricher 
from running out of memory when large SAI files are 
used. 

 

Table 3 - Problems Fixed 

Number Location Description 

QCCR1C19089 Server The schedule name correctly supports 255 characters.  

QCCR1C19165 Server Deleted devices no longer appear in the modeling queue. 

QCCR1C19242 Server 
Fixed premature log rolling (before the 20MB threshold) for 
the discovery.log. 

QCCR1C19310 Server 
The DDM Inventory server can correctly display the 
percentage sign (%) and slash (/) in VMware system names. 

QCCR1C19588 Server 

The device reconciliation logic can correctly handle all cases 
where VMware and scanner reported information needs to 
be merged into one device model. 

QCCR1C29277 Server 

The Discovery Engine will now filter out incoming VMware 
host models if all of the IP addresses listed in the model are 
outside of the configured IP ranges. 

QCCR1C29328 Server 
VMware discovery scheduling has been improved to avoid 
request collision. 

QCCR1C29369 Applets 

DDM Inventory will now show an error message, “Express 
teaching has not been configured", if you try to teach an 
application and the Express Teaching applet option is 
disabled. 

QCCR1C29427 Server 

When performing a level 3 data delete, the System Panel 
will now correctly close the status window that appears 
while the data is being deleted. 

QCCR1C29606 Server 
Isolated database corruption no longer occurs during 
product upgrade.  

QCCR1C29884 
QCCR1C30526 Scanners 

The Scanner can scan directories that start with the tilde 
“~” character. 

QCCR1C30280 SAI Editor 
The SAI Editor can remember the size and location of the 
“Importing from Scanfile Comparison” window. 

QCCR1C30299 Scanners The Scanner can handle very long directory names. 

QCCR1C30318 AIX Scanner 
MAC Address detection has been improved to collect 
information when cards are disabled or not connected. 
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Number Location Description 

QCCR1C30324 SAI Editor 
The directory names will not be mixed up when teaching 
from scan file comparison. 

QCCR1C30550 Server 

DDM Inventory server no longer has problems importing 
events. The server used to run out of disk space due to such 
errors.  

QCCR1C30596 Applets 
The Find tool can find all devices if an IP address is 
associated with multiple devices.  

QCCR1C30654 Documentation 
The document now correctly states the most recent ODBC 
version. 

QCCR1C30703 Server 
DDM Inventory server can correctly monitor the Scheduler 
status.  

QCCR1C30805 

Server > 
Administration > Data 
Management > Agent 
download The agents can be downloaded from the Web UI properly. 

QCCR1C30865 Agent 

The Windows Agent will properly run without memory or 
file handle leaks on Windows 2000 Advanced Server, 
Windows 2000 Server, and Windows 2000 Professional. 

QCCR1C30886 Solaris Scanner  The Scanner can detect all of the package files. 

QCCR1C30939    Server 
Very low bandwidth settings no longer cause failures during 
file transfer in Agentless mode. 

QCCR1C30954 HP-UX Scanner  
The HP-UX Scanner will not hang if the lanadmin 
command hangs. 

QCCR1C30956    Agentless 
The custom location of the scanner is now correctly used 
when an Agentless scanning workflow runs on Windows. 

QCCR1C30965 Windows Scanner 

During the targeted directory scanning, if a shortcut points 
to an executable on the root of the C: drive, the Scanner can 
scan the entire C: drive. 

QCCR1C30968 
SPARC Solaris 
Scanner 

The Scanner can detect the service level on Solaris 8 
machines. 

QCCR1C30970 

Server > 
Administration > Data 
Management > Import 
device and port data 

If you enter an invalid file name from Server > 
Administration > Data Management > Import device and 
port data, an error message shows "Invalid or non-existent 
filename entered". The "Browse" button becomes disabled. 

QCCR1C30976 Web UI The page navigation correctly appears on the Firefox 3.x. 

QCCR1C31019 Solaris Scanner 
The Scanner reports Solaris zone states correctly with 
Solaris 10 Update 7 or later. 

QCCR1C31023 Server 

After performing a level 1 delete, it is no longer necessary to 
restart the System Monitor before using the Express 
Teacher applet in the DDM Inventory interface. 

QCCR1C31037    Server 
Agentless scanning over SSH no longer fails if the SSH 
session does not start in $HOME as its current directory. 
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Number Location Description 

QCCR1C31052 Scanners 

Scanners on some platforms, such as HP-UX (ia64) and 
Solaris (SPARC), no longer crash when scanning some 
executable files. 

QCCR1C31060 SAI Editor 
The same font is used for the Installed Package and Version 
Data tree view headers. 

QCCR1C31082 Windows Scanner Windows scanners can detect the Itanium 2 CPU properly. 

QCCR1C31119 Server 

The device reconciliation mechanism has been improved to 
correctly handle Solaris zones models with multiple IP 
addresses. 

QCCR1C31218 Server 

When running VMware discovery on a VMware host or 
VirtualCenter, the network adapter information is 
processed properly. The VMware host is no longer deleted 
from the database mistakenly. 

QCCR1C31221 Server 

The XML Enricher no longer hangs when processing some 
scan files that have large sections of the override.ini 
data specified in the scanner parameters. 

QCCR1C31223 HP-UX HPPA Scanner
Error code 6 no longer appears when saving offsite scan 
files to HTTP URL on HP-UX 11.11. 

QCCR1C31302 
 
AIX Scanner  

The Scanner can detect multiple IP addresses on the same 
network card. 

QCCR1C31499 

Server > 
Administration > 
Discovery 
Configuration > 
Device Groups 

When creating new device groups, the configuration UI will 
no longer display the values of previously edited profiles. 

QCCR1C31581 Server 

The incoming Call Home request does not cause fatal error 
any more if the scanning workflow is already in progress for 
the device. 

QCCR1C31597 Linux Scanner  
The Scanner can show the SCSI device labels correctly on 
computers with more than 26 devices. 

QCCR1C31760 Server 

The SNMPv3 protocol implementation has been made more 
robust against agents that can change their security 
parameters (engineBoots and engineTime) in an 
unexpected way (decrease engine boot count and/or engine 
time). This can also happen if several devices share the 
same securityEngineID for SNMPv3 agent 
implementation. 

QCCR1C31849 Server 
The Discovery Engine will suppress the generation of the 
error "No session available to talk to ACS". 

QCCR1C31874 Windows Scanner 

The hwCPUSpeedRated field is no longer populated when 
the scanner is running inside a Hyper-V virtual machine 
because the data in SMBIOS is not correct. 
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QCCR1C31879 Agent 

The agents can retrieve scan files from Czech Windows or 
other platforms using non-ASCII characters in the directory 
name. Non-ASCII characters are now handled properly by 
the agents. 

QCCR1C31901 HP-UX Scanner 
The scanner now populates the hwOSServiceLevel field 
with the service pack information. 

QCCR1C31958 Server 

The Discovery Engine will now use DNS names returned by 
VMware host modeling process. The name is used in the 
device title (default configuration). 

QCCR1C31991 

Server > Reports > 
Applications > By 
Application> 
Application Details 

When you go to “Server > Reports > Applications > By 
Application” and click any application, the navigation link 
path correctly shows as "Server > Reports > Applications > 
By Application > Application Details". 

QCCR1C32086 Server 

If the incoming VMware host model cannot be reliably 
merged to any of the existing nodes, the Discovery Engine 
will now try to merge the new VMware host model into an 
IP-only node rather than creating a new node. 

QCCR1C32125 Installer 
Changed "Enterprise Discovery" to "DDM Inventory" in one 
of the installer screens. 

QCCR1C32210 Hardware Definitions 

The caption for the 
hwsmbiosProcessorCharacteristics hardware field 
has been corrected. 

QCCR1C32322 Server 

The Discovery Engine runs properly when the following two 
actions occur simultaneously: the scanner deployment 
workflow is running; and a new device is discovered with an 
IP address that already has been used as a preferred IP for 
another device in the database. 

QCCR1C32377 Server 

When running the VMware discovery process on a 
VirtualCenter that manages a large number of hosts, the 
Discovery Engine would close the VMware discovery session 
after 3 minutes if there was no response from the 
VirtualCenter. The timeout has now been increased to 15 
minutes. This enables the VMware discovery process to 
complete in environments with a large number of VMware 
hosts. 

QCCR1C32378 UNIX Scanner 
The Scanner no longer hangs when scanning circular 
symbolic links. 

QCCR1C32421 
XML Enricher 
Analysis Tools 

The XML Enricher and Analysis Tools no longer crash when 
processing some scan files containing version data rules. 

QCCR1C32529 Viewer 
Removing an application with rules no longer causes 
crashes in the SAI Editor when the rules tab is selected. 

QCCR1C32614 Windows Scanner 

The Scanner no longer leaves hidden, system, or read-only 
files in the TEMP directory when the local scan file saving 
is disabled and the off-site destination points to an FTP or 
HTTP server. 
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QCCR1C32655 SAI Editor 

The SAI Editor no longer hangs when creating a new 
release in an application that has both version data and 
installed package rules 
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Known Problems, Limitations, and Workarounds  

Agents 

• When the Agent is installed on Windows Vista machines using an account other than the 
"Administrator" account, the firewall exception is not added into the exceptions list (QCCR1C382).  

• On Mac OS X 10.4.10 and above, there may be a problem with contacting the Agent because it can be 
blocked by a firewall. The Agent port needs to be enabled manually either via System Preferences > 
Sharing > Firewall or via the XServe administration tool in case of centralized administration 
(QCCR1C674). 

Scanners 

• In the Scanner Generator if a previously generated file is used to populate the Scanner Generator 
options and software scanning is disabled, the Scanner will still attempt to store any previously 
configured custom stored files (QCCR1C19042). 

• Scanners may fail if the scanner log file is extremely large in size (QCCR1C20445). 

• In some cases the hwMonitorSerialNumber collected by the Windows scanner may differ between 
previous versions of DDM Inventory and DDM Inventory 7.6x. (QCCR1C30340). 

• If a domain controller is scanned and has an extremely large number of user profiles, the XML Enricher 
may take a long time to process the scan file (QCCR1C30571). 

• In some cases the wrong registry key may be read when running the Scanner on a Windows XP 64-bit 
machine (QCCR1C30657). 

• In some cases, the Scanner may not properly detect the number of cores on an Intel E5520 CPU 
(QCCR1C30814). 

• The monitor serial number collected from some brands of monitors may not be correct (QCCR1C31570). 

• In some cases an unmanaged device with more than one network card may fail to run the Scanner 
because of an upload error (QCCR1C32128). 

• If the Solaris scanner runs inside a Solaris Local Zone, the CPU information for the Logical, Physical or 
Cores counts may not be correct (QCCR1C32454). 

• The DNS field in the scan file that contains the DNS entry for the primary IP may not be detected on 
some UNIX machines if a DNS server is not configured (QCCR1C32533). 

• The Linux scanner may fail and exit when run on SUSE Enterprise Desktop 9 update 4 
(QCCR1C32691). 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the “Treat field as 
a File Name’’ option is selected, the “Replace invalid characters with’’ field must be populated as well, 
even if the “Delete invalid characters’’ option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (QCCR1C1275). 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (QCCR1C1480). 
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• The Analysis Workbench sample script does not run on Windows 2008 because the default directories 
are not set correctly. The script works properly on all other supported platforms (QCCR1C19475). 

Server Installation 

• After uninstalling, the branding registry keys are left over (QCCR1C1434).  

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(QCCR1C16520 and QCCR1C1472). 

• When uninstalling DDM Inventory on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (QCCR1C2405). 

• DDM Inventory with a Network Topology license should not be installed on VMware (QCCR1C5271). 

• The SNMP extension registry key may not be removed on some Windows 2008 server installations 
(QCCR1C29306). 

• After a new installation, opening the SAI Editor for the first time may show a warning message 
(QCCR1C32445). 

• If DDM Inventory is upgraded from a previous version, the certificate date may not be updated 
(QCCR1C32481). 

Server 

• In some cases, the ID assigned to the auto.zsai and the user.zsai files may be the same. This 
results in the inability to load both files into the client tools at the same time (QCCR1C4448). 

• Older OpenSSL DLLs in the system PATH can affect the DDM Inventory Apache server and Perl 
engines (QCCR1C5447). 

• If your server has another service using port 80, the HP Discovery Apache service will not run properly. 
As a workaround, you can comment out the “Listen 80’’ directive in the httpdf.conf file 
(QCCR1C6670). 

• If there is a MySQL query that takes too long, DDM Inventory will not function properly and you may 
need to restart System Monitor to recover (QCCR1C7409). 

• VMware discovery may, in some cases, use an incorrect IP address if the VMware image has been 
recently powered off (QCCR1C19379). 

• Sometimes when logging into the DDM Inventory server, a pop-up window opens with the message 
“Jscript compilation error: Expected ‘}’”.  This problem occurs as a result of calling Java Applets from 
Internet Explorer (this issue does not seem to occur with Firefox). The problem is not specific to DDM 
Inventory and can be seen on various Web pages where Applets are present. Note that the pop-up 
window opens with this message only if the “Disable script debugging” option is enabled. Otherwise, if 
this option is enabled, only a warning icon (yellow triangle containing an exclamation mark) will appear 
on the left-side of the Internet Explorer taskbar when this problem occurs. This problem has occurred on 
both Internet Explorer version 6 and version 7 (QCCR1C19591). 

• If a non administrative user logs into the Windows server, an error indicating that the syspanel.log 
file cannot be created may occur (QCCR1C20437). 

• If agent and agentless scanning is enabled for a property group, in some cases installing and then 
uninstalling an agent may result in DDM Inventory not recognizing that a device has an agent on it 
(QCCR1C29364). 
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System Panel 

• When there are multiple instances of the DDM Inventory System Panel running on the Server, only one 
of the System Panel instances will display Port Usage information (QCCR1C20409). 

Web User Interface 

• After an agentless scan (using SSH) has successfully been run, the account used for this connection 
cannot be changed unless the account from the DDM Inventory UI is deleted (QCCR1C19398). 

Applets 

• When upgrading, the applet may not recognize a new license until the server has been restarted 
(QCCR1C32483). 

Administration 

• Depending on the licenses, the “Resource/ Environment manage’’ option in Discovery Configuration may 
not have any effect (QCCR1C7034). 

• In the Service Analyzer, device breaks may show up in the filter list for line breaks (QCCR1C18988). 

• If the recognition type is set to Installed Applications, the auto.zsai file will not be created 
automatically (QCCR1C30353). 

Web Asset Questionnaire 

• In Internet Explorer, when connecting to the main page through a proxy server, the “You are connecting 
from’’ IP address reported will be the IP address of the proxy server not that of the remote computer 
address (QCCR1C764). 

• The UI may show non-printable characters in text fields (QCCR1C2408). 

Reports 

• The + symbol in the Navigation Tree next to reports is missing. This does not affect functionality 
(QCCR1C18894). 

• When using HP Client Automation Enterprise Reporting Server, some new CPU type may not be 
displayed correctly (QCCR1C19380). 

• The Alarm summary of Collisions, Frame Relay FECN/BECN, DE Inventory reports and Device Load 
Average may report N\A instead of the correct values (QCCR1C29312). 

Licensing 

Alarms License  

• Alarm-related items are not always hidden (QCCR1C5673). 
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Internationalization 

• Various UI screens (reports, status reports, Device Manager, and so on) format the “day of the month’’ 
part of the date as Arabic numerals instead of using the language option configured by the operating 
system (QCCR1C416). 

• When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 
Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 
information (QCCR1C490). 

• There are several problems with the SAI Editor accepting characters in the Korean code page 
(QCCR1C507, QCCR1C508). 

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (QCCR1C2043). 

• SAI files with non-English names may appear incorrect when viewing them with the DDM Inventory 
web user interface (QCCR1C19372). 

• If the name of a User zSAI file contains non-English characters, the XML Enricher may not be able to 
load that zSAI file (QCCR1C19402). 

• Recognition rules written in non-English characters may not recognize all versions (QCCR1C19610). 

• Some non-English locales may not report the total disk space correctly in some cases (QCCR1C19614). 

• Virtual Machine names with non-English characters appear as invalid characters. (QCCR1C29618). 
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